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The application provides many features to help you navigate through, access, and share your
information. This guide explains various navigation tools in the application and how to use features
such as the home page and favorites.

General Navigation
The application includes a variety of navigation features that give you increased control over the
software.
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Navigation and Explorer Bars
Pages in the application include the following features:
• Navigation bar: The navigation bar allows you to navigate through the application and return to
your home page. Your role in the application determines the appearance of the navigation bar, and
it only displays features that you have permission to access.

• Explorer bar: From the explorer bar, you can quickly access recently performed searches, recently
viewed records and pages, and shortcuts. Based on the current page, you can also access related
tasks and activities.

Summary Tiles
Some pages in the application include summary tiles. Summary tiles allow you to quickly view, add,
and edit information. Tiles often link to other pages and tabs. You can use these links as shortcuts to
navigate throughout the program.
For some pages, each application user can customize which tiles are visible. You can also change the
order in which they display.
Tiles respect security settings. If you do not have permission to access the information that a tile links
to or displays, that information does not appear.
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Shortcuts for My Profile
On the My Profile page, you can use the Shortcuts feature to create shortcuts to pages and records
that you access frequently. You can specify pages as shortcuts to access them from the Shortcuts
menu on the explorer bar.
You can also organize, rename, and delete shortcuts and email shortcut links.

Add a shortcut
1. Open the location you want to save as a shortcut.
2. On the explorer bar, click Add this page to shortcuts.

Or
1. Under Shortcuts, clickManage my shortcuts. The My Profile page displays.
2. Click Add a task. The Add tasks to shortcuts screen displays. All functional areas in the

application containing tasks to which you can create a shortcut display in the Functional area
box.

3. Select the functional area that contains the task(s) to which you want to link. All tasks display in
the Task box.

4. Select all tasks to which you want to create a shortcut.
5. Click Save.
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6. Once a shortcut has been added, you can rename, delete, move, or email a link to the shortcut.
Select the shortcut you wish to modify:

l Select Rename to modify the name of the shortcut. Enter the desired name and click Save
to rename the shortcut.

l Select Delete and press Yes to delete the shortcut.
l Select Email link to generate an email message that includes a link.
l SelectMove to top,Move up,Move down, orMove to bottom to move the link to the
desired location.

Home Page
The Home page appears when you start the application. To return to it, click Home on the navigation
bar. You can add any page in the program to your shortcuts for ease of navigation. This can be useful if
you work primarily in one area of the application or want a certain page to be easy to access. From any
page you want to add to your shortcuts, click Add this page to shortcuts on the left navigation.

Application-Level Search
The application-level search function helps you find a specific feature in the application when you do
not know its location. The search field available at the top of any application page accesses a search
engine. Based on the search option you select, the engine searches the program and returns links to all
pages, tasks, RSS feeds, and help documentation that satisfy the search criteria. The search engine also
overlooks minor spelling errors and respects system security.

Feature Search
A feature search is a quick navigational tool that searches all areas of the application — pages, tasks,
RSS feeds — for information that satisfies your search criteria. It is the most general of the search
options and likely generates the most results.
For example, if you enter “add constituent” in the search field, the Search Results page displays links
to areas in the program that match the words “add” and “constituent.” On the Search Results page, if
you click a task link such as Add an individual, the task is invoked and the Add an individual screen
appears for you to enter a new constituent. If you click a page link such as Constituent Giving
Information, a search screen appears and you can search for the constituent whose information you
want to view.
To execute a feature-level search, click Application features beside the search field and select the
feature to search. Enter your criteria in the search field and click the magnifying glass. The results
appear on the Search Results page.
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Context-Based Feature Search
In the search field, you can include context information and refine your feature search. For example, to
locate Robert Hernandez’s constituent record, rather than search for just “constituent record,” you can
include the constituent name: “constituent info?rob hernandez.” In the search results, you can click links
to various constituent areas in the program with information about Robert Hernandez. When you click
a link, constituent information appears or a search screen appears with a list of matching records.
In the search field, you can also call up and display ad-hoc and smart query results. For example, if you
have an “Ohio Constituents” ad-hoc query, you can enter “query?Ohio Constituents” in the search field.
When you click Ad-hoc Query Results in the search results, the Ad-hoc Query page appears for the
“Ohio Constituents” query. From this page, you can browse records, edit the query definition, create an
export, create tasks, and assign permissions.

Note: For information about Query, refer to the Query chapter in the Query and Export Guide.

RSS Feed Search
RSS feeds in the program are included by default in feature-level searches. However, you can search
for RSS feeds only. This limits the number of results and provides a way to view RSS feeds available.
To restrict your search to RSS feeds, click Application features and select RSS feeds. Enter your search
criteria in the Find field and click Search. Only RSS feeds that match your search criteria appear on the
Search Results page.
Click an RSS feed to access the feed page in the program. From this page, you can review feed data
and subscribe to the feed.

Quick Find Search
With the quick find functionality, you can search for and open specific records in the application.
For example, if you click Application features and select Appeals, you can enter “Fall Mailing” in the
search field to search for the fall mailing appeal record. If a single record matches your criteria, the
record opens. If multiple records match your criteria, a search screen appears with a list of matching
records. You can refine your criteria and execute a new search to locate the desired record.

Configure Search
Although the search function includes some items by default, you can edit the search list and expand
this number.

Edit Search Lists
When a feature search returns a feature that requires context, the search page must be able to resolve
the context. Context on a feature is always tied to a specific record type, as are search lists; however,
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each record type can have multiple search lists associated with it. For these records types, you must
manually map to the search list to use. For example, the batch record type includes three search lists:
batch template search, batch search, and batch type search. With the Default search list configuration
option in Administration, you can select the list to use in your searches.

Select search lists for record types
1. From Administration, under Configuration click Default search lists. The Default Search Lists

page appears. This page displays a list of record types mapped to related search lists.

2. Click Edit. The Define the default search list for system record types screen appears.
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3. On the Default search list column, select the list to use for the record type.
4. Click Save. You return to the Default Search Lists page. Your changes appear in the grid.

Add New
If you want to quickly add a new item to the system, you can use the Add new button next to the
search field. A list of the most commonly added items will display. Select an option to display the add
screen for that item.

Rearrange Tabs
You can now drag and drop tabs and subtabs into any order you prefer. This is a sticky setting, so it is
saved the next time you access any record of the same type. This allows you to organize the tabs in the
order that makes sense for your workflow. Any record that uses tabs, such as Constituents, Revenue,
Events, and so on, can use this feature.

Note: There is no way to reset the tabs to their default setting once they have been moved. They
must be moved manually in order to reset them to the default.

Calendars
Various calendars are used throughout the application to provide a view of scheduled items related to
your organization or community. These can include upcoming events, mailings, holidays, or other
items related to the specific calendar currently open. In addition to an effective view of scheduled
items, many calendars provide tools to add and edit items directly from the calendar, which can save
you time.
Although the calendars displayed throughout the application may have different purposes, they each
have several common components to help you more effectively view and interact with information.
For example, filters provide a way to narrow or expand the items displayed on the calendar and color-
coding helps you identify items.
To help customize calendars for how you work, you can change the colors used to identify specific
items on the calendar. To change the colors defined for each item that appears on the calendar, click
Customize style. In the grid, within the Style column, click the down arrow and select a color to assign
to each. Click OK to save.

Workspace for Your System Role
If your role allows, you can access a workspace from your home page to view and manage tasks
associated with your role and key performance indicators (KPIs) to track the effectiveness of your
efforts. You can also access the organization calendar to view activities scheduled at your organization.
By default, you can access the workspace from your home page. On the default home page, click
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Development workspace. The Workspace page appears and displays information pertinent to your
role.
If your organization enables email alerts, you can configure and manage your email preferences from
the Workspace page. For example, you can enter the email address to receive alerts or select whether
to receive specific alerts. Under Tasks, click Email preferences. Your application user record appears.
For information about how to configure email preferences, refer to the Administration Guide.
Depending on your role and the activities you perform, the workspace may contain multiple tabs to
help you navigate through the information.

Organization Calendar
On the Organization Calendar tab, you can view scheduled items related to your organization or
community, such as to help schedule and coordinate activities and processes. From the calendar, you
can add and manage calendar items such as holidays, community events, or scheduled breaks in your
organization’s operation. You can also select the type of activities to view during a specific period of
time.

Note: For information about how to add and manage items or set filters on the Organization
Calendar, refer to the Administration Guide.

My Assignments
On the My Assignments tab, you can view and manage assignments related to your system role. For
example, if you work with mailings or interact with constituents, your mailings and constituent
interactions appear underMy assignments. If you work with batch entry, batches assigned to you such
as for data entry or approval appear. You can select whether to display only a specific type of
assignment and whether to display completed assignments. To filter the grid, select the criteria for the
assignments to view and click Apply. To remove the filter, click Reset. To update the information in
the grid, click Refresh List. From the grid, you can add and manage your assignments as necessary. To
view additional information about an item related to an assignment, such as a batch or an interaction,
select it in the grid. The record of the item appears.

Note: If your role allows, you can manage your batches from the Workspace page. To access the
Batch Entry page, such as to manage additional batches, under Administration click Batch. For
information about batch entry, refer to the Batch and Import Guide.

Donors
If your role works with revenue transactions, the Donors tab appears. Under Donors, you can view the
constituents associated with recent pledges and payments toward donations or recurring gifts. You can
select the recent time period of the transactions to view, such as Today or This month. You can also
select to view only transactions above a specific revenue amount within the selected time period. To
filter the grid, select the criteria for the transactions to view and click Apply. To remove the filter, click
Reset. To update the information in the grid, click Refresh List. To view additional information about a
donor, select the donor in the grid. The record of the constituent appears.

KPIs
On the KPIs tab, you can view key performance indicators (KPIs) to track the effectiveness of activities
pertinent to your role. KPIs track your strategic performance to help determine a course of action.
When you monitor your business activity with KPIs, you can place a value on otherwise difficult to
measure activities such as leadership development. To view the value of a KPI, select it under KPIs. To
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update the value of a KPI, such as to include recent activity, select it in the grid and click Update KPI
value. To view additional information about a KPI, select it in the grid. The record of the KPI appears.

Note: If your role allows, you can view your KPIs from the Workspace page. To access the KPI
Instances page, such as to add or manage KPIs, under Analysis click Information library. For
information about KPIs, refer to the Reports and KPIs Guide.

Smart Queries
On the Smart Queries tab, you can view smart queries to access records based on criteria pertinent to
your role. Smart queries are designed to allow you to easily create a query that is not ad-hoc but
groups records based on specific criteria such as SYBUNT (constituents who gave Some Year But
Unfortunately Not This year). You can use smart queries for the same purposes as ad-hoc queries, such
as to casually browse records or generate a selection for use in other processes. To view the results of
a smart query, select it under Smart queries. The record of the smart query appears.

Note: If your role allows, you can view your smart queries from the Workspace page. To access the
Query page, such as to add or manage smart queries, under Analysis click Information library. For
information about query, refer to the Query and Export Guide.

Change Password
All users should change their passwords the first time they log into the application and on a regular
basis according to your organization’s security policy.

Note: If your organization does not host the program through Blackbaud and does not use
organizational units, please contact your system administrator for information about how to change
your password.
All passwords are case sensitive and must meet the following complexity standards:
• A password cannot be the same or too similar to a previously used password.
• Passwords must be at least fourteen characters in length.
• Passwords must contain at least three of the following four character types: uppercase letters (ABC),
lowercase letters (abc), numbers (123), or symbol characters (!@#).

Change your password
1. On the menu bar, in the upper-right, clickWelcome and select Change password.

The Change password screen appears.
2. In the Old password field, enter your current password.
3. In the New password and Confirm password fields, enter a new password that meets the

following complexity requirements:
l A password cannot be the same or too similar to a previously used password.
l Passwords must be at least fourteen characters in length.
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l Passwords must contain at least three of the following four character types: uppercase
letters (ABC), lowercase letters (abc), numbers (123), or symbol characters (!@#).

4. Click Save.

Refresh a Page
When you work in the application, you might encounter a situation where a record is changed by
another user while you view it. If this happens, the information on the page might be inaccurate. You
can refresh the page to display the most current information in the database.

Filters
The Filter button allows you to customize entries in data lists. You can use the Filter button to select
record types to display in a list or to select a date range. The filter options that appear depend on the
type of data in the list.
For some data lists, the filter options always appear above the lists. For other data lists, you must click
Filter to open the filter options.

The filter options that appear depend on the data list.

When you apply filters to a list of items, the application remembers your filter settings and uses them
as defaults the next time you view the list. For example, if you typically are only interested in the most
recent transactions on a constituent’s revenue history, you can apply a date range filter of “Last week.”
When you go to any constituent record and view the revenue history, it uses the default filter and
displays only transactions that took place in the last week. If you apply a date range filter of “Last
quarter,” the next time you view the revenue history, it displays transactions from the last quarter.
Filter settings are stored for each user, so a user’s defaults do not impact anyone else. Filter settings are
also stored across sessions, so you can log out and log back in and still see your defaults.

Note: There are also filters on some dashboards and reports; however, these settings are not stored
and must be reapplied each time you access the dashboard or report.
You can also sort the information that appears in a datalist by clicking on a column heading. For
example, you can click on a Date column heading and items will be listed in chronological order. Sort
options are not stored and must be reapplied each time you access the datalist.
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Really Simple Syndication (RSS)
You can use the program to publish lists of data, such as registrations for an event, as Really Simple
Syndication (RSS) feeds. RSS is a simple XML-based system that lets users subscribe to content such as
news or website updates and then aggregate it into a single location using RSS-aware software. With
this feature you can target important information to members of your organization. Users who
subscribe to the RSS feed can view the information as it is updated in the program. For example, an
RSS feed can supply the person responsible for a special event with up-to-date registration
information.

Use the RSS feature
1. Locate a data list that has been RSS-enabled in the application. The View RSS feed icon

denotes a data list that can be subscribed to as a feed.

2. Click View RSS feed. A link to the feed opens in your default web browser.

Note: The link to the RSS feed is in the form of a text-based URL. For example, https://<SERVER
NAME>/<SERVER PATH>/<RSS FEED LINK>.
3. If the web browser supports RSS, it can give you the option to subscribe to the feed.

4. You can use the browser’s built-in functionality to subscribe to the feed, or you can copy and
paste the link to the RSS feed into a preferred software or service. The method used to view
the feed determines how it looks.

5. The link to the RSS feed can also be shared with other users. You can send the URL and they
can view the feed with an RSS-enabled software or service. As the information is updated in
the program, the information in the related RSS feed is visible to all subscribers.

Mark Data as Inactive
When you delete information from the database, you cannot recover that data. As an alternative, you
can mark data such as constituent records or membership program levels as inactive. This allows you to
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retain the information in the database but exclude it by default from lists, search results, queries, and
reports.
To mark data as inactive, you select it in the grid and either clickMark inactive in the action bar or
under Tasks in the explorer bar. You can use filter options in the program to include inactive data in
lists, search results, queries, and reports.

To restore inactive data, you select it in the grid and either clickMark active in the action bar or under
Tasks in the explorer bar.

Navigation Tree
The navigation tree is an efficient way to view multiple, nested pages of information. The navigation
tree displays information as an expandable, hierarchical set of links to other pages. This lets you to see
the big picture rather than a single path.
For example, you can open a fundraising purpose and get a broad view of all the activities involved by
displaying links to all of the associated appeals.
If a navigation tree is available, it is collapsed on the top-right side of the page. To expand the
navigation tree, click the link.

Note: When using the Help Panel, navigation trees display next to the page name. When legacy Help
is used, navigation trees display on the top-right side of the page. For more information about help
configuration, refer to Configure Help Type.

Access the navigation tree
1. Navigate to a page with a navigation tree. The navigation tree is collapsed on the top-right

side of the page.

Note: When using the Help Panel, navigation trees display next to the page name. When legacy
Help is used, navigation trees display on the top-right side of the page. For more information
about help configuration, refer to Configure Help Type.
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2. Click the link. The navigation tree appears. Click the link again to close the navigation tree.

3. When the navigation tree is open, you can view information about connected pages.
• To expand and collapse the nested groups, click the plus and minus icons beside the page.
• To access a page, place your cursor over the page name and click the link.

KPI Dashboard
All users have a personal dashboard, displaying key performance indicator (KPI) data. The dashboard
includes data from every KPI instance that the user has permissions to.
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The KPI dashboard stores all KPI values and statistics in an easy to view format. You can modify the
Time span to make it easier to access the information you need. You can also export the information
to Microsoft Excel or MicrosoftWord or generate a PDF.
For more information about KPIs, refer to the Reports and KPIs Guide.

Lists
There are two types of lists in the program: data lists and list builder lists. List builder lists include
more advanced options for sorting and navigating the data on the list.

The following features are available in data lists and list builder lists.
l To sort the grid data by a specific column, click the column header. The column is sorted in
ascending order. Click the column header again to sort in descending order.

l To auto-size list columns, clickMore, Autosize all columns. The columns will adjust to fit the
largest piece of data contained within each column.

l To revert back to the grid defaults, clickMore, Restore grid defaults.

Tip:
After you make desired list changes, we recommend you save your list for future access. You
can save as many lists as you need to segment and review data.

You can also complete tasks for records on the list. To access task buttons, click the double arrows next
to a record to expand the row. Expanded rows may also include additional information about the
record.
After you create a list, you can download the information for future reference. You can download a list
as a comma-separated values (.CSV) file or a Microsoft Excel (.XLSX) spreadsheet. For example, you can
download a .CSV file of addresses to provide to a mail house, or export an Excel spreadsheet for use
outside of the program.

l To download a list, clickMore and then click Download to CSV or Download to XLSX.
l To save a list, click Save list. In the Save list screen, enter a name and description to identify the
list and click Save.

l To open a saved list, click Open list. In the Open a list screen, click the name of the list. To
narrow down the lists that appear, search for a list by its name.
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Note: Saved lists are visible to any user that has access to that data list. However, saved lists do
respect data security permissions.

Note: Not all lists currently support the save and open list features.
These features are exclusive to list builder lists:

l To filter data in a column, click the filter icon.
Enter your filter criteria based on the data in the column. For example, for a date-based column,
you can enter date criteria, such as all donations after 11/1/2012. For name-based columns, you
can enter the name by which you want to filter, such as all registrants with the last name
Williams.

l You can search for specific list items in the Search field. The program uses your criteria but only
searches through the first 500 records that display for the list. Before you use the search, we
recommend you use the column filters to narrow down the results.

l To select which columns to display, click Columns and select which columns to show and hide.
Use the Search field to quickly find a column by name. 

l To reorganize columns in the grid, drag and drop a column header.
l Columns and filters are sticky by user.

Documentation
On the Documentation tab, you can add notes to track helpful or interesting information about your
records. You can save links to websites or related materials stored outside of the program. You can
also attach items directly to records. When you attach a file, the program stores a copy in the database.

Attachments
You can attach items to records. When you attach a file, the program stores a copy in the database.

Add Attachments
You can use attachments to track additional details about records. When you attach a file, the program
stores a copy in the database.

Add an attachment
1. Go to the Documentation tab of a record.
2. Click Add attachment. The Add an attachment screen appears.
3. Select an attachment type. Enter the date, title, and author. To search for the attachment, click

Choose file.
4. Click Save. You return to the Documentation tab.
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Add an Attachment Screen

Screen Item Description
Type Select the type of attachment. The system administrator configures attachment types.

Date Enter the date of the attachment.

Title Enter the title, or purpose, of the attachment.

Author To search for the author, click the binoculars. A search screen appears.

File To locate the attachment, click Choose file. To view an attachment, click Open file. To remove
an attachment, click Clear file.

Edit Attachments
On the Documentation tab, you can edit an attachment. You can remove a file and choose a different
file. You can also view an attachment.

Edit an attachment
1. Go to the Documentation tab of a record.
2. Click the double arrows beside an attachment and click Edit. The Edit attachment screen

appears.
3. Make changes as necessary to the attachment type, date, title, or author. To view an

attachment, click Open file. To remove an attachment, click Clear file. To select a different file,
click Choose file.

4. Click Save. You return to the Documentation tab.

Delete Attachments
After you add an attachment to the Documentation tab, you can delete it as necessary.

Delete an attachment
1. Go to the Documentation tab of a record.
2. Click the double arrows beside an attachment and click Delete. A confirmation message

appears.
3. Click Yes. You return to the Documentation tab, and the attachment no longer appears.
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Media Links
On the Documentation tab, you can save links to websites or related materials stored outside of the
program.

Add Media Links
When you add a media link, you enter the website address.

Add a media link
1. Go to the Documentation tab of a record.
2. Click Add media link. The Add a media link screen appears.
3. Select a media link type. Enter the date, title, and author. Enter the URL for a website.
4. Click Save. You return to the Documentation tab.

Add a Media Link Screen

Screen Item Description
Type Select the type of media link. The system administrator configures media link types.

Date Enter the date of the media link.

Title Enter the title, or purpose, of the link.

Author To search for an author, click the binoculars. A search screen appears.

Media URL Enter the URL for a website.

Edit Media Links
You can edit the URL for a website.

Edit a media link
1. Go to the Documentation tab of a record.
2. Click the double arrows beside a media link and click Edit. The Edit media link screen appears.
3. Make changes as necessary to the media link type, date, title, or author. You can edit the URL

for a website.
4. Click Save. You return to the Documentation tab.
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Delete Media Links
After you add media links to the Documentation tab, you can delete them as necessary.

Delete a media link
1. Go to the Documentation tab of a record.
2. Click the double arrows beside a media link and click Delete. A confirmation message

appears.
3. Click Yes. You return to the Documentation tab, and the media link no longer appears.

Notes
On the Documentation tab, you can add notes to track helpful or interesting information about your
records.

Add Notes
On the Documentation tab, you can track notes about your records.

Add a note
1. Go to the Documentation tab of a record.
2. Click Add note. The Add a note screen appears.
3. Select a note type. Enter the date, title, author, and the content of the note.
4. Click Save. You return to the Documentation tab.

Add a Note Screen

Screen Item Description
Type Select the type of note. The system administrator configures note types.

Date Enter the date of the note.

Title Enter the title, or purpose, of the note.

Author To search for an author, click the magnifying glass. A search screen appears.

Notes Enter the content of the note.
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Edit Notes
On the Documentation tab, you can edit notes as necessary.

Edit a note
1. Go to the Documentation tab of a record.
2. Click the double arrows beside a note and click Edit. The Edit note screen appears.
3. Make changes as necessary to the note type, date, title, author, or note content.
4. Click Save. You return to the Documentation tab.

Delete Notes
After you add notes to the Documentation tab, you can delete notes when necessary.

Delete a note
1. Go to the Documentation tab of a record.
2. Click the double arrows beside a note and click Delete. A confirmation message appears.
3. Click Yes. You return to the Documentation tab, and the note no longer appears.

Notifications
Notifications allow you to share important information about a record or a group of records with
users. You can determine whether all users should receive a notification or only a targeted group of
users. For example, you notify all users to when they open the record of a board member.
Notifications are not available for every record type. They are available only for:
• Bank Account Adjustment records
• Bank Account Deposit records
• Bank Account Deposit Correction records
• Constituent records
• Event records
• Membership records
• Planned Gift records
• Research Group records
• Revenue records
Notifications appear on the information bar of a record.
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Note: Notifications for constituents also appear in the Constituent Window of a revenue batch.
You can also set notifications to appear on a separate screen when users view a record. The notification
screen appears the first time a user views a record during a session. If you leave the record and return
within 60 minutes, the notification screen does not appear again. However, if you return after more
than 60 minutes, the notification screen appears again.
You can create notifications for groups of records in Administration. You can also create notifications
for a record from the Documentation tab of the record.

Add Notifications to Specific Records
On the Documentation tab, you can add a notification to a note on a record. You can select or create a
note with the notification’s message and add the notification to the note.

Add a notification
1. Go to the Documentation tab of a record.
2. Select a note to use for the notification. The note’s title and text appear as the notification.

Note: You must add a note to the record before you can add a notification.
3. Click Add notification. The Add notification screen appears.
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4. Select how long to display the notification, whether to display it in a notification window, and
the users who view the notification.

5. Click Save. You return to the Documentation tab.

Edit Notifications for Specific Records
After you add a notification to a record, you can edit its properties on the Documentation tab. You can
change how long to display the notification and who views it. To edit the notification’s content, you
edit the note associated with the notification.

Edit a notification
1. Go to the Documentation tab of a record.
2. Click the double arrows beside the note with the notification and click Edit notification. The

Edit notification screen appears.
3. Make changes as necessary to the notification, such as how long to display it and who views it.

Note: To edit the notification title or content, edit the note itself.
4. Click Save. You return to the Documentation tab.

Delete Notifications from Specific Records
On the Documentation tab, you can delete a notification when you no longer need it.

Note: For a constituent record, go to the Documentation and Interactions tab. Then click
Documentation.
To remove a notification from a record, click the double arrows beside the note with the notification
to remove and click Delete notification.
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Open Attachment Files
After you add an attachment on the Documentation tab, you can open the attachment. To do this, click
the double arrows beside the attachment and click Open file.

Reports Toolbar
When you generate a report, you can use the report toolbar to modify how you view the report. The
toolbar buttons are common to all reports.

Toolbar item Description

First Page On a report with multiple pages, click this button to return to the first page.

Previous Page On a report with multiple pages, click this button to return to the previous page.

Current Page The chronological number of the selected page appears. To navigate to a specific page, enter the
page number and press ENTER.

Next Page On a report with multiple pages, click this button to return to the previous page.

Last Page On a report with multiple pages, click this button to go to the last page.

Refresh To refresh information to include new or updated data, click this button.

Export To select a file format for exporting, click this button. File types include XML file with report data, CSV
(comma delimited), TIFF file, pdf file, Web archive, Excel, andWord. Note: In exported reports, such
as PDF versions of the reports, some items may appear as links. These currently direct you to the
Blackbaud website, instead of to the specific records in the program.

Search Text To search the report for a word or phrase, enter the text in this field and click Find.

Find To search for text entered in the Search Text field, click this button.

Next To search for the next instance of text in the Search Text field, click this button.

HTML Editor
The program provides a powerful HTML editor to allow you to format and lay out content. With the
HTML editor, you can update content easily and safely while you maintain control over the design and
content.
You can use the HTML editor in different views, depending on your HTML experience and where you
access the HTML editor in the program.
• Normal – When you open the HTML editor to create or edit content, this is the “normal” view. This
view is similar to a standard word processing application. By default in normal view, when you
press ENTER, you create a <p> tag in the HTML content to indicate a new paragraph. When you
press SHIFT + ENTER, you create a <br> tag to indicate a single carriage return in the content.
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• HTML – To view or edit the HTML source code, click HTML Code on the View tab in the toolbar.
The HTML Source Editor screen appears. To return to the normal view, close the window. You
cannot use the HTML view to embed your own form via HTML in the HTML editor. We recommend
you put the form on a page that is not stored in the program but can be referenced in an iFrame.
For more information about how to include customized forms in the program, contact Blackbaud’s
Professional Services at solutions@blackbaud.com.

• Preview – To view the content as it will appear on the web page and to test hyperlinks, click
Preview on the View tab in the toolbar. The Preview screen appears. To return to the normal view,
close the window.

HTML Editor Functions
These tables explain the buttons and menus on the toolbar of the HTML editor. Some features have
more buttons available than others.

Note: On your website, users can use an HTML editor with a limited set of these buttons on some
parts. With the HTML editor, users can also insert images, tables, or links.

Buttons on the Toolbar

Button Function Description
Full screen To work in full screen mode, click Full screen. To turn off full screen mode and view

the screen at its normal size, click Full screen again.

Preview To view the content as it will appear on the web page, click Preview. The Preview
screen appears. To return to the normal view, close the window.

Print To print the current content, click Print. The Print screen appears. Select the printer
and your print preferences, and click Print.

Edit HTML
source

To view or edit the HTML source code, click Edit HTML source. The HTML Source
Editor screen appears. To return to the normal view, close the window.

Clean up
HTML

To remove unnecessary tags from the HTML, click Clean up HTML. The Clean Up
HTML screen appears. With the buttons on this screen, you can remove all HTML
tags, remove all MicrosoftWord-specific markup, clean up stylesheets, clean up
<Font> tags, and clean up <Span> tags.
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Button Function Description
Spell check To check the spelling, click Spell check. When you turn the spell checker on, it checks

the spelling of all existing content in the HTML editor and will check new content as
you create it. When the spell checker finds an error, a red squiggly line appears below
the word. Right-click the underlined word to select the correct spelling. You can also
spell check in different languages. Use the drop-down to the select the language.

Find and
replace

To find and replace text, click Find and replace. The Find/Replace screen appears. In
the Find what field, enter the text to search for. In the Replace with field, enter
replacement text. To search for the text, click Find next. To replace the text, click
Replace. To replace all instances, click Replace all.

Cut To remove text from the content area and copy it to the clipboard, click Cut. The text
is removed, and you can paste it elsewhere in the content area.

Copy To copy text to the clipboard, click Copy. You can paste the text elsewhere in the
content area.
Note: For Firefox, security settings disable the Copy button. To copy text to the
clipboard in Firefox, highlight it and press CTRL-C.

Paste To paste text from the clipboard, click Paste. The text appears in the content area. It
retains the formatting fromwhen you cut or copied it.
Note: For Firefox, the Paste button in HTMLmode removes HTML tags. To paste text
with HTML tags in Firefox, press CTRL-V. For Firefox on Macs, you cannot paste text
with HTML tags in HTMLmode because Ctrl-V also removes the HTML tags.

Paste plain
text

To paste text from the clipboard without any formatting, click Paste plain text. The
text appears in the content area and does not retain its formatting.

Paste from
Word

To paste text from the clipboard that you copied fromMicrosoftWord, click Paste
from Word. The text appears in the content area without the proprietary HTML of
Word. The text format may differ from the format inWord.

Insert page
break

To insert a printed page break, click Insert page break. The HTML editor adds a
division with an attribute of PAGE-BREAK-BEFORE: always at the selected location.

Insert
horizontal
rule

To insert a horizontal line, click Insert horizontal rule in the toolbar. On the screen
that appears, enter the width and height for the line and select whether to include a
shadow.

Insert custom
characters

To insert a special character, click Insert custom characters. The Custom characters
screen appears. In the grid, select a character. The custom character appears at the
selected location.
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Button Function Description
Insert anchor To link to a specific location on a page, place your cursor at the link’s endpoint (for

example, a heading) and click Insert anchor. The Insert/edit anchor screen appears
so you can enter a name for the anchor’s location. The HTML editor adds <a
name="anchor name"></a> before the defined location. In the normal view, the
HTML editor displays an anchor symbol at the defined location.

To link to the anchored location, in the HTML source view, append “#anchorname” to
the end of the link.

Insert image To insert an image, click Insert image. On the Select Image from Image library screen,
you can select the image.

Insert link To link text to a web address or web page, click Insert link. If the text is in a format
that the program recognizes as a web address or page, such as www.abc123.org, the
link formats automatically. Otherwise, the page link screen appears.

Remove link To remove a hyperlink from text, click Remove link. The text no longer acts as a
hyperlink.

Undo To undo the last action in the content area, click Undo. The action is reversed. You
can undo multiple actions.

Redo To redo an undone action in the content area, click Redo. The action is reinstated.
You can redo multiple actions.

Help To access a description of the HTML editor features, click Help. The help file appears.

Insert table To insert a table, click Insert table. The Insert/edit table screen appears. For more
information about option on this screen, see HTML Editor Table and Line Properties
on page 37. After you create a table, you can select it and click Insert table to edit its
properties.

Delete table To delete a table, select it and click Delete table.

Row
properties

To edit the properties of a row, select it and click Row properties. The row properties
screen appears. For more information about row properties, see HTML Editor Table
and Line Properties on page 37.

Cell
properties

To edit the properties of a cell, select it and click Cell properties. The cell properties
screen appears. For more information about cell properties, see HTML Editor Table
and Line Properties on page 37.

Insert row
above

To insert a row above a row in a table, click Insert row above. A new row appears.

Insert row
below

To insert a row below a row in a table, click Insert row below. A new row appears.

Delete row To remove a row from a table, click Delete row. The row is deleted.
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Button Function Description
Insert column
to the left

To insert a column to the left of a column in a table, click Insert column to the left. A
new column appears.

Insert column
to the right

To insert a column to the right of a column in a table, click Insert column to the
right. A new column appears.

Delete
column

To remove a column from a table, click Delete column. The column is deleted.

Split merged
table cells

To split a cell that spans multiple rows into two cells, click Split merged table cells.
The selected cell no longer spans the row on the bottom.

Merge table
cells

To merge a cell with the cell to its right, clickMerge table cells. Any content in the
cell on the right is removed, and the selected cell now spans both columns.

Show table
borders

To hide or reveal the borders of your tables, click Show table borders.

Insert new
layer

To insert a layer, click Insert new layer. The HTML editor adds a layer using the <div>
tag. To reposition the layer, select the layer and use the crossed arrows to drag the
layer to the new location. To resize the layer, drag the resize handles found at the
layer’s corners or sides.

Move layer
forward

To move a layer forward, select the layer and clickMove layer forward. The HTML
editor increases the z-index number for the layer.

Move layer
backward

To move a layer backward, select the layer and clickMove layer backward. The HTML
editor decreases the z-index number for the layer.

Absolute
positioning

To apply absolute positioning to a selected layer, click Absolute positioning. The
HTML editor adds the position: absolute tag to the layer and its location on the page
in pixels. To remove absolute positioning from the selected layer, click Absolute
positioning again.

Direction left
to right

To apply left to right directionality to all items in the division, click Direction left to
right. For a left to right table, column zero is on the left side and row zero is at the
top.

Direction
right to left

To apply right to left directionality to all items in the division, click Direction right to
left. For a right to left table, column zero is on the right side and row zero is at the
top.
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Button Function Description
Block quote To insert a long quotation, click Block quote. The HTML editor adds a <blockquote>

tag around the selected text.

Abbreviation To add a tooltip that defines an abbreviation, select the word and click Abbreviation.
The Abbreviation Element screen appears so you can enter the abbreviation’s
definition in the Title field and define formatting for the tooltip. The HTML editor
adds an <abbr> tag around the selected word. When viewed in a browser, the
abbreviation is underlined and a tooltip appears when you place your cursor over the
underlined word. Screen readers read the abbreviation as a word, rather than spell
out the letters.

Acronym To add a tooltip that defines an acronym, select the word and click Acronym. The
Acronym Element screen appears so you can enter the acronym’s definition in the
Title field and define formatting for the tooltip. The HTML editor adds an <acronym>
tag around the selected word. When viewed in a browser, the acronym is underlined
and a tooltip appears when you place your cursor over the underlined word. Screen
readers read the acronym as a word, rather than spell out the letters.

Citation To add an in-line citation or reference to another source, select the word or phrase
and click Citation. The Citation Element screen appears so you can enter text in the
Title field for the citation’s tooltip (such as the author, book title, and page number
(s) or a link to a website) and define formatting for the tooltip. The HTML editor adds
a <cite> tag around the selected word or phrase. When viewed in a browser, the
citation is usually italicized and the tooltip appears when you place your cursor over
the italicized word or phrase.

Bold To make text bold, click Bold. The HTML editor adds a <strong> tag around the text.

Italic To italicize text, click Italic. The HTML editor adds an <em> tag around the text.

Underline To underline text, click Underline. The HTML editor adds a <u> tag around the text.

Strikethrough
text

To strike a line through text, click Strikethrough text. The HTML editor adds a
<strike> tag around the text.

Superscript To strike a line through text, click Strikethrough text. The HTML editor adds a
<strike> tag around the text.

Subscript To strike a line through text, click Strikethrough text. The HTML editor adds a
<strike> tag around the text.

Align left To align text to the left, click Align left. The HTML editor adds an attribute of
align=left to the division.

Align center To align text to the center, click Align center. The HTML editor adds an attribute of
align=center to the division.
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Button Function Description
Align right To align text to the right, click Align right. The HTML editor adds an attribute of

align=right to the division.

Align full To fully justify text, click Align full. The HTML editor adds an attribute of align=justify
to the division.

Remove
format

To remove formatting from text, click Remove format. The HTML editor removes any
special format attributes, and the text appears as plain text.

Text color To change the color of text, click Text color and select a color from the palette. The
HTML editor adds a <span> tag with the color around the text.

Highlight To highlight text, click Highlight and select a color for the highlight from the palette.
The HTML editor adds a <span> tag with the background color around the text.

Insert
numbered
list

To insert a numbered list, click Insert numbered list. The HTML editor adds an <ol>
tag at the selected location. The items are numbered sequentially, starting with “1.”
To end a list, click Insert numbered list again.

Insert
unordered
list

To insert a bulleted list, click Insert unordered list. The HTML editor adds an <ul> tag
at the selected location. The items in the list have bullets. To end a list, click Insert
unordered list again.

Indent text To increase an indent, click Indent text. The HTML editor adds a <blockquote> tag
around the paragraph. If you increase the indent for a list item, the number or bullet
changes to indicate a secondary relationship to the list.

Outdent text To decrease an indent, click Outdent text. The HTML editor removes the
<blockquote> tag around the paragraph. If you decrease the indent of a list item,
the text becomes plain text. If you decrease the indent of a secondary list item, the
number or bullet becomes part of the parent list.

Stylesheet
options

To render content on a page, the program uses the stylesheet associated with the
page’s layout. To view your content with stylesheets applied and edit the content for
a specific stylesheet, click Stylesheet options. On the Stylesheet Options screen, you
can select the stylesheet to view and override the background and foreground colors
of the HTML editor to improve readability. For more information about how to view
content with stylesheets applied, see Style Sheet Options on page 36.
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Button Function Description
Insert
conditional
content

To add conditional content to an email message to customize the message for
different types of recipients, click Insert conditional content. On the Conditional
Content screen, you can create the first conditional content block. You can then
define the content and select the group of recipients who view it.

This button appears only on the add/edit screens for templates, messages, and
newsletters.

If you send an email message from Blackbaud Direct Marketing, this option does not
appear.

View
conditional
content

To verify that conditional content appears as expected for each group of recipients,
click View conditional content. The View Message screen appears.

This button appears only on the add/edit screens for templates, messages, and
newsletters.

If you send an email message from Blackbaud Direct Marketing, this option does not
appear.

Insert merge
fields

To add merge fields with personalized information to the HTML content, click Insert
merge fields. For more information, see Merge Fields on page 35.

Insert content
placeholder

On the add or edit layout screen, you can click Insert content placeholder to add
panes for parts to the layout. A yellow icon appears as a placeholder for a pane.
When you create templates and web pages, a pane contains multiple parts. You
select the parts to appear in the pane.

Menus on the Toolbar

Menu Menu name Description
Font menu This menu lists common fonts that appear correctly on most web

browsers. To change the font applied to text, select a font.
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Menu Menu name Description
Size menu To change the size of text, select a size from this menu.

Paragraph
menu

To apply a paragraph tag to text, select a format from this menu.
For example, select “Normal” for body text.

Merge Fields
To create personalized content, use merge fields to display offline information. For example, in an
email, you can insert the First name merge field so it displays “Hello, <First name>” to the recipient.
• To add merge fields, clickMerge fields on the Insert tab in the HTML editor toolbar. The merge
fields list appears in a separate window that you can move around.

• To view the available fields, click the plus sign next to a group of fields to expand the list.
• You can double-click or drag and drop merge fields from the window to the content area.
• You can add multiple fields at a time. To do this, place your cursor to the left or right of the group
name or fields (not over the group or fields) and click and drag your mouse to select them. After
the fields are selected, you can drag them as a group to the content area.
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Style Sheet Options
On your website, the program uses the style sheet associated with a web page’s layout to render the
content you enter in the HTML editor. Because the part on which you enter the HTML content may be
shared across multiple web pages with different style sheets, you may need to edit the content as
necessary to improve its readability with a specific style sheet. When you use the HTML editor in the
normal view, you can view the content as it appears with different style sheets applied.

View HTML content with a specific style sheet applied
1. On the View tab in the HTML editor toolbar for formatted text and images parts, click Style

sheet options. The Style sheet Options screen appears.
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2. In the Edit using style sheet field, select the style sheet to apply to the content in the HTML
editor.

3. Depending on the style sheet, the background and foreground colors of the HTML editor may
affect the readability of your text. Change the background and foreground colors of the HTML
editor as necessary to edit the content.
a. Select Override style sheet colors.
b. Select the color to adjust. For the background color, click Select next to Editor background

color. For the foreground color, click Select next to Editor default font color.
The Select a color screen appears. Using the tabs, you can pick a color three different ways or
enter its hexadecimal value in the Color field.

c. Click Apply. You return to the Style sheet Options screen.
4. Click OK. You return to the HTML editor. The content appears with the selected style sheet and

colors applied.

HTML Editor Table and Line Properties
In the normal view, you can use the HTML editor to design tables, table rows, table cells, and
horizontal lines that divide the web page. You can also adjust the properties for these items to
determine characteristics such as size, styles, and color.
• To create a table, click Table on the Insert tab in the HTML editor toolbar. The Insert/Edit Table
Screen appears. On the General and Advanced tabs, you can design the table and adjust its
properties. We recommend only users familiar with HTML and CSS style elements adjust the
properties on the Advanced tab. For more information, seeInsert/Edit Table Screen on page
38Insert/Edit Table Screen on page 38.

• To edit the properties of a row in a table, select the row and click Row properties on the Table tab
in the toolbar. The Table Row Properties screen appears. On the General and Advanced tabs, you
can design the row and adjust its properties. We recommend only users familiar with HTML and
CSS style elements adjust the properties on these tabs. For more information, see Table Row
Properties Screen on page 40.
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• To edit the properties of a cell in a table, select the cell and click Cell properties on the Table tab
in the toolbar. The Table Cell Properties screen appears. On the General and Advanced tabs, you
can design the cell and adjust its properties. We recommend only users familiar with HTML and
CSS style elements adjust the properties on these tabs. For more information, see Table Cell
Properties Screen on page 42.

• To insert a horizontal line, click Horizontal ruler on the Insert tab in the toolbar. On the screen that
appears, enter the width and height for the line and select whether to include a shadow.

Insert/Edit Table Screen
To create a table, click Table on the Insert tab in the HTML editor toolbar. The Insert/Edit Table Screen
appears. On the General and Advanced tabs, you can design the table and adjust its properties. We
recommend only users familiar with HTML and CSS style elements adjust the properties on the
Advanced tab. After you create a table, you can select the table and click Table to edit its properties.
General Tab

Screen Item Description
Cols Enter the number of columns.

Cellpadding Enter the amount of space to appear between the ruled line and the content of a cell in
the table.

Alignment Select the horizontal alignment of the table. You can select Left, Center, Right, or Not
Set.
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Screen Item Description
Width Enter the pixel dimensions to use for the cells.

Class Select the CSS class to apply.

Table caption Select this checkbox to display a caption at the top of the table. To remove the table
caption, clear the checkbox or delete its code in HTMLmode.

Rows Enter the number of rows.

Cellspacing Enter the amount of space to appear between cells of the table.

Border Enter the width, in pixels, of a border around the table. To display the table with no
border, enter “0.”

Height Enter the pixel dimensions to use for the cell.

Advanced Tab

Screen Item Description
ID Enter a unique identifier for the table.

Summary Enter a summary of the table, such as for speech-synthesizing or non-visual browsers.

Style Enter the CSS class to apply to the table.
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Screen Item Description
Language code Enter the language code for text in the table, such as “en-US” for United States English.

This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.

Background image To insert an image that appears as the background of the table or cell, click Browse to
open the Image library and select an image.

Frame Select this checkbox to display a caption at the top of the table To remove the table
caption, clear the checkbox or delete its code in HTMLmode.

Rules Select which ruled lines appear between cells of the table. You can select to display all
lines, no lines, or only those between rows, columns, or groups.

Language direction Select the directionality for text in the table — left to right or right to left.

Border color Enter the color for the border of the table. You can enter the standard color name or
hexadecimal value, or click Browse to select the color from the palette.

Background color Enter the color for the background of the table. You can enter the standard color name
or hexadecimal value, or click Browse to select the color from the palette.

Table Row Properties Screen
To change the properties of rows in the table, select a row and click Row properties on the Table tab
in the HTML editor toolbar. The Table Row Properties screen appears. We recommend only users
familiar with HTML and CSS style elements adjust the properties on the Advanced tab.
Use the field at the bottom of the screen to select which rows to update with changes — the current
row, odd rows in the table, even rows in the table, or all rows in the table.
General Tab
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Screen Item Description
Row type Select Header, Body, or Footer for the row type.

Alignment Select the horizontal alignment of the row. You can select Left, Center, Right, or
Not Set.

Vertical alignment Select the vertical alignment of the row. You can select Top, Center, Bottom, or Not
Set.

Class Select the CSS class to apply to the row.

Height Enter the pixel dimensions to use for the row height.

Advanced Tab
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Screen Item Description
ID Enter a unique identifier for the row.

Style Enter the CSS class to apply to the row.

Language direction Select the directionality for text in the row — left to right or right to left.

Language code Enter the language code for text in the row, such as “en-US” for United States English.
This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.

Background image To insert an image that appears as the background of the row, click Browse to open
the Image library and select an image.

Background color Enter the color for the background of the row. You can enter the standard color
name or hexadecimal value, or click Browse to select the color from the palette.

Table Cell Properties Screen
To change the properties of cells in the table, select a cell and click Cell properties on the Table tab in
the HTML editor toolbar. The Table cell properties screen appears. We recommend only users familiar
with HTML and CSS style elements adjust the properties on the Advanced tab.
Use the field at the bottom of the screen to select which cells to update with changes — the current
cell, all cells in the row, all cells in the column, or all cells in the table.
General Tab
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Screen Item Description
Alignment Select the horizontal alignment of the cells You can select Left, Center, Right, or Not

Set.

Vertical alignment Select the vertical alignment of the cells You can select Top, Center, or Bottom.

Width Enter the pixel dimensions to use for the cell width.

Class Select the CSS class to apply to the cell.

Cell type Select whether the cell is a header for a column or includes data.

Scope Select whether the cell type applies to the column, row, group of columns, or group
of rows.

Height Enter the pixel dimensions to use for the cell height.

Advanced Tab
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Screen Item Description
ID Enter a unique identifier for the cell.

Style Enter the CSS class to apply to the cell.

Language direction Select the directionality for text in the cell — left to right or right to left.

Language code Enter the language code for text in the cell, such as “en-US” for United States English.
This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.

Background image To insert an image that appears as the background of the cell, click Browse to open
the Image library and select an image.

Border color Enter the color for the border of the cell. You can enter the standard color name or
hexadecimal value, or click Browse to select the color from the palette.

Background color Enter the color for the background of the cell. You can enter the standard color name
or hexadecimal value, or click Browse to select the color from the palette.
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